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W hat is Respondus?

Respondus is a software program used to create and edit exams. Test questions can be imported from word
processing documents and exported to various learning management systems including Canvas.

The Repondus Interface

Review the numbered and lettered items for further details each item in the interface.

Figure 1
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1
Open or Create Open a Respondus file. e
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Create a new Respondus file. °
E] Create

Locate a publisher test bank and select questions for e
an exam.

Test Bank
Network

Create an exam by copying items from other e
@ Exam Respondus Files.

Wizard

Import Import questions from a text file. e
Questions

Archi Create a Respondus archive file so that questions, media,
rchive and equations are stored as a single, compressed file.

Wizard

1. Top Menu - This menu allows includes options to edit questions directly in Canvas and control some
settings for the test as well as the publish options.

2. Current Personality - When working with Respondus be sure to set the personality to Instructure Canvas
before working with any content.

3. Open or Create screen — The introduction screen includes several options for building your tests.

a. Open - Open a Respondus file

Create - Create a new Respondus file.

Test Bank Network - Locate a publisher test bank and select questions for an exam

Exam Wizard - Create an exam by copying items from other Respondus files.

Import Questions —Questions can be imported from a Word or text file.

O

Archive Wizard - Create a Respondus archive file.
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Preparing the Q uiz Fik to In port mto Regpondus

Respondus can accept Microsoft Word documents (*.doc & *.docx), plain text (*.txt), rich text (*.rft), and
comma delimited (*csv) file formats. The test questions and answers must be formatting properly so the correct
answers are marked by Respondus. Follow the steps below to make sure multiple choice questions are formatted
properly.

Open the exam file in Word. Questions should be formatted as the examples in the table below. In each example
each question must be formatted with a number followed by a period or parentheses and a space. Each answer
should be formatted with letter followed by a period and space. The correct answers can be identified adding
additional formatting in one of two ways. In the example 1 an asterisk is placed by the correct answer for each
question. In example 2, the answers are placed at end of the document with heading Answers: above. Save the
document as a text file, rich text file or a Word document and close the document. Follow the steps in the next
section for importing the file into Respondus.

Figure 1.3:
Example 1: Example 2:
1. Rose works at this department store when we | 1. Rose works at this department store when we
first meet her in the first episode. first meet her in the first episode.
*a. Harrods a. Harrods
b. Macys b. Macys
c. JC Penneys c. JC Penneys
d. Target d. Target
Answers:
1.A

Tip: For Respondus to interpret the correct answer accurately the asterisk must come before the lettering for
each answer in a text question. In Word automatic numbering makes this difficult. Create your test as you
normally would using the automatic numbering. Then when you are finished save your file and then go to File >
Save As to create a copy of test in plain text. Close Word and open the file in Notepad. To open Notepad go to
Start > Accessories > Notepad. In the plain text document all of the numbering will be retained and you will be
able to place the asterisk in the correct location.

=Tk

File Edit Format View Help

1. Rose works at this department store when we first meet her in the first episode. -
*a. Harrods
macys

JC Penneys
Target

N QNT

when the Doctor takes Rose 5 billion years into the future she meets Cassandra who is

a. dalek
Tast Tiving human
time Tord
robot

QNoTw
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O ptionalFom atting forM uliplk Choice Q uestions

In Canvas questions in question bank will have a title. It is important to have good titles for your questions so
they are easy to find in Canvas. You can add this information in your document so it will be included in the
Respondus file you publish to Canvas.

Titles and General Feedback

Multiple choice questions do not need the type formatting but other questions types will to be imported
correctly. Place the type on a line above the question text and type TYPE: with a space after the colon. Then type
the code for the question type (see next page for details). To add the title hit the Enter key and type TITLE: with
space after the colon. Then type the desired title. The general feedback that displays below the question in
Canvas can be added after the question text but before the answers. Use a tilde symbol for correct answers and
the @ symbol for incorrect answers.

Type: MC

Title: MC Actor Trivia 1

1. The Doctor in season 1 was played by

~ That is correct!
@ That is incorrect. Please review module 1.

a. Matt Smith

b. David Tennant

*c. Christopher Eccleston
d. Peter Capaldi

Feedback for Each Answer

To add feedback for each answer, the feedback must be placed on the line below the answer. Use a tilde ~symbol
for correct answers and the @ symbol for incorrect answers.

Type: MC
Title: MC Actor Triva 2

2. The Doctor in season 2-4 was played by

a. Matt Smith
@ No! Matt Smith was Doctor for seasons 5-7.

b. David Tennant

~ Yes! This is the correct answer

c. Christopher Eccleston
@ No! Christopher Eccleston was Doctor for season 1.

d. Peter Capaldi
@ No! Peter Capaldi currently plays the Doctor.
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Form atting O ther Q uestion Types

Other question types can be imported from a Word document; however, there are some additional formatting
that is required so Respondus can identify the question type properly. For all question types the title is optional.
The type is required for all question types except T/F and Multiple choice questions.

Fill in the Blank Questions (Short Answer)

Fill in the blank questions may be imported by starting the first line of formatting with “Type: F”. This identifies
the question as a Fill-in-the-blank question. This is followed by the “Title”. Fill-in-the-blank questions are
similar to short answer questions and only allows one correct answer per question; however, multiple variations
can be added so Canvas will auto grade the question if the student types the answer in one of the listed
variations.

Example:

Type: F

Title: FIB Actor Triva 2

3. The Doctor in season 1 was played by .
a. Chris Eccleston

b. Christopher Eccleston

c. Eccleston

Essay Question

Essay questions are identified by adding the line above beginning with “Type: E”. This is followed by the “Title”
(which is optional), the question number, and the question wording. In Canvas essay questions must be
manually graded.

Example:

Type: E

Title: Doctor Essay Q1

4. Who is your favorite Doctor and why?

Importing True or False Questions

The process of importing “true or false” questions is similar to that used for importing multiple choice questions
(see above). Both of the following examples are valid ways to format a true and false question for importing
purposes. It’s important to note that the “True” (or “T”’) answer choice must be listed prior to the “False” (or

“F””) answer choice in order for Respondus to recognize it as a true and false question type. (If “False” appears
first in the list, the question will be imported as a “multiple choice” question).

Example:

Title: TF Doctor Knowledge
5. The Doctor has two hearts.
*a. T

b. F
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Importing Matching Questions

The process of importing a “matching” question is similar to what is described above for importing multiple
choice questions, but there are some key differences. The first line of formatting must begin with “Type: MT”.
This is followed by the “title” (which is optional), the question number, and the question wording.

Each answer (which consists of both parts of a correct match) must begin with a letter (a-t) followed by a period

« » >

”[period] or “)”[a parentheses]. The two parts of the match must be separated with an “=” symbol and there
should not be any hard returns or blank lines within either parts of the answer. Spaces before or after the “=”
symbol are optional, but it is important that an answer only uses the = symbol for the purpose of separating the
two parts of the match. If you plan to list correct answers for other questions at the bottom of the document,

simply skip the number for all questions that are of the matching variety.

Example:

Type: MT

Title: Matching Actor Triva 1

6. Match the Actor/Doctor with Companions
a. Matt Smith = Amy Pond

b. David Tennant = Donna Noble

c. Christopher Eccleston = Rose Tyler

d. Peter Capaldi = Clara Oswald

Importing “Multiple Response” Questions

The logic for importing questions that allow multiple responses (named “Multiple Answers” questions in
Instructure Canvas) is similar to what is described above for importing multiple choice questions. (Multiple
Response questions are, essentially, multiple choice questions in which more than one correct response can —
and generally should - be selected by the student). The primary difference is that the first line of the formatting
must begin with “Type: MR” (as an alternative, you can use “Type: MA” which stands for “Multiple Answers”).
This is followed by the “Title” (which is optional), the question number, a space, and the question wording.
Each correct answer is designated with an asterisk.

Example:

Type: MR

Title: MR Companions

7. Mark all companions who rode in the TARDIS with eleventh Doctor.
*a. Amy Pond

b. Donna Noble

c. Rose Tyler

*d. Clara Oswald

*e. Rory Williams

*f. River Song
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Importing Test Questions

Open Respondus and make sure the Start tab is displayed. Next to Current Personality select the option
Instructure Canvas. On the start screen click Import Questions. The Import Questions dialog box will appear.
Review the numbered items below.

Figure 2

Import Questions 5'

1. Select the file to Import: Cancel I
Type of file: lPIain Text Zl 0/ Help I

File name: [D octoriwho-1-additional-formatting. tat Browse I

Image Folder |T:\Canvas-Documentation‘\Respondus Browse I

2. Choose where to add the new Questions:
(" Append the questions to the current document. e i

% Create a new document, named:  |Mod01

Type of file to create: (& Exam ¢ Survey
[~ Use "stem" plus question number to create litle, e.q. |
"'ch01-" stem becomes "'ch01-001", “ch01-002", ... J
3. Use the Preview button to check for problems: ‘ -
.
4. Press the Finish button to complete the process. Finish . @

— Preview results R

¢ | Title | Question Wording a2 | -;—I
Rosz Rose works at this department store when w

Cassranéra \When the Doctor takes Rose 5 billion vears i

Charles Dicken: Op Rose's first trip back in time she meets

Slitheen 1 In the Aliens of London episode the Doctor 1

Slitheen 2 What issue do the Slitheen aliens have wher 2}

Warnings and Notes: -
* These questions had no answer [so answer set to 'a'):
28910111213 1415

Wb (W R | e

=

1. Instep 1 select the type of file your test is and browse the location of the file on computer’s drive.

2. In step 2 select the option next to Create a new document, named: and give new Respondus file a name.

3. If you want test questions to have what Respondus calls a “stem”, place a check in the box next to Use “stem”
plus question number to create title, e.g. “ch01-.” stem becomes "ch01-001, ch01-002”. Type the beginning of
the stem in box (e.g. ch01-). If this option is not selected, Respondus will use the first few words from the
question as the title.

4. Instep 3 click Preview. The list of questions will display in the preview results. If there are no warnings
below it click Finish. The Respondus Edit screen will appear. If you see errors in the Warnings and Notes
box, see the troubleshooting guide on the next page.
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Troubkshooting the W ammng and N otes Preview W ndow

In the Import dialog box the Warning and Notes area of the preview window may display errors that occurred
during the import process. There are some troubleshooting steps an instructor can take to correct the errors and
try importing the document again.

Step 1: Review the Word Document

Sometimes the error is in the Word document. Minimize the Respondus window and open the test document in
the Word to double check for formatting errors. The most likely issues with formatting are missing periods after
a number or letter or a missing asterisk next to correct answer. Make corrections and save the file. Close the
document. Maximize the Respondus window and in the Import Questions dialog box click Preview again. If the
Warnings and Notes area displays a message that says “no warnings” click Finish. If there are still errors, review
the next step.

Step 2: Remove all formatting in the Word File

Minimize the Respondus window and open the exam in the Word. In the Word document select all text by
clicking CTRL + A on the keyboard. On the Home tab click the Clear Formatting button. Save and close the
tile. Maximize the Respondus window and in the Import Questions dialog box click Preview again. If the
Warnings and Notes area displays a message that says “no warnings” click Finish. If you continue to receive
errors, review the next step.

Figure 3

m H - 0§- - Respondus-Canvas-Handout.docx - Word ? B - O X

AILINGS REVIEW VIEW DEVELOPER ADD-INS snugent ~
% Find ~

e Replace

HOME INSERT DESIGN PAGE LAYOUT REFERE

-y

Avenir LTStd( |14 -| A A" | A~ TiE S [ EE AT aasbed. AaBbCel AaBbC AaBhb AaBbC AaBbCc

Fo. R Caption  TNormal NoSpacing Headingl | Heading2 = Heading3 |

Paste B I U-acx,x |A-¥-A-

:
. : -
~ Format Painter v

n

[3 Select ~

Clipboard [ Font [ Paragraph 7] Styles ~ Editing ~

Step 3: Save the Word file as a Plain Text File

In Respondus click Cancel in the Import Questions dialog box and minimize the Respondus window. Open the
Word document. In Word click the File tab and select Save As. In the Save dialog box choose Plain Text (*.txt)
in the drop down menu next to Save as Type. Click Save and close the file. Maximize the Respondus screen and
click Import Questions and repeat steps 2-5 in the Import Questions dialog box again. On step 2 select Plain
Text file from the drop down menu. If the Warnings and Notes area displays a message that says “no warnings”
click Finish.

Figure 4

File name: Some text. txt M

| —
Save as type: @l Eg e ‘.txt v

N [ Save ][ Cancel
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Ushg the EAdi Screen

Once a file is imported into Respondus the Edit screen will display. Review the numbered items below.

Figure 5

File Edit View Help

BY | &BB B 2 U|x |2 | @veds | Qponeredt | ?

(TR /T
Settings |~ §review Instructure Canvas
Edit Questions Multiple Choice ll
1. Title of Question  [Mod01-001 e—
Multiple Choice 2. Question Wording Correct/Incorrect Feedbackl“\
True/False Rose works at this department store whe#% first meet her in the
[ Essay Question first episode.
Matching
Fillln the Blank 3. Answers (PageDown moves to next answer) ﬂielalMl ™ Feedback
Multiple Answers 4 |Harrods ﬂ
{ Fill in Multiple Blanks —
e g |Macys
Text (no question)
 Numerical Answer C— JC Penneys
— p— —0——
4. Select Correct Answer |4« 5. PointValue |[1.00 v’
6. Save Changes I Cancel Changes | Clear Form | Preview
Questiobgiat a3 %7 0o SN e e e s sansntaatanssansansansansannsansenp ExpandedView| Towlltems 15 Points 150
# \ itle Format [ Points [ Quastion Wording =
|1 [P X| Mod01-001 Multiple Choice 1.0 Rose works at this department store when we first meet her in the first episode.
(2 | P x| Mos01-002 Multiple Choice 1.0 When the Doctor takes Rose 5 billion years into the future she meets Cassandra who is &
(3 | P x| Mos01-003 Multiple Choice 1.0 On Rose's first trip back in time she meets .
|4 | P x| Mos01-004 Multiple Choice 1.0 |n the Aliens of London episode the Doctor must deal with what aliens?
5 | P X| Mod01-005 Multiple Choice 1.0 What issue do the Slitheen aliens have when they disguise themselves as humans? =
[_ Search I Advanced Search I
1. Inthe question list click the chevron (down pointed arrow) next to the question to edit the question. Click

the Preview icon next to each question to preview OR click Expand View to view the list of questions in the
expanded view. Additionally, you can create new questions in Respondus or copy questions from another
Respondus /Test Bank Network file as well.

2. When a question is edited the question will display at the top of screen. You can make desired changes to the
question title, question box, and question answers.

3. Click Correct/Incorrect Feedback button to add any desired correct and incorrect feedback for this
question.

4. Click General Feedback to create general feedback comments in the question feedback box. In the answer
boxes type or edit answers in each box (options will vary from question type).

5. Review the selected correct answer and point value. Click the drop down menu to change the correct answer
and type in a new point value if desired. Click Preview to preview how the question will appear in the web
browser. Click Save Changes when done editing the question.
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Exam Settmngs

Once a test has been created with Respondus you can modify the text settings on Settings tab in Respondus
before you publish the text to Canvas. Open the file you wish to modify. Click Settings on top of the Respondus
screen. Note: This is optional. Quiz settings can also be set up in Canvas as well.

Figure 6

T@ Respondus - ModO1.rsp
File Edit View Help

HY & BB B 27 U | xx |2 | Bveda | Qroweredt | ¥

( Start Settings ~ Faview

Creating Question Groups

On the Settings screen click Question Groups. The Question Sets screen will appear. Click the Questions
Groups. The Question Sets dialog box will appear.

Figure 7
Before using this task, you should first place all questions in the desired order. See the . . .
online help for additional instructions and guidelines. | or M Od lfy or De le te Existin g Se L.
Total ltems: 15 Points: 15.0 Cancel |
2. In the two boxes below type the number of the
¢ AddNew Set " Modify or Delete Existing Set: v I ‘0} . . .
first question in the set and number of the last
Enter the number of the FIRST question to be used in the set |1 e . . .
Enter the number of the LAST question to be used inthe set |15 ).'0.. questlon n the set. USC the numbers m the
- 3 . . .
How many questions in this set should be randomly selected during the exam? "0‘ ﬁr st COlumn (the graY section WIth # Slgn
Ca @ seectuner [0 ) : above) in the question preview view below the
Enter the point value that should be used for questions in this set |2 @ .0. . .
options. You may need to use the scroll bar in
Add New Set I an®®® Help . . .
the dialog box to see all the questions in the
% | gl Satd Tittenwww = ** [ Formar | Question Wording | 4] uiz
[P | Modol-001 Multiple Choice Rose works at this department store wi quiz.
(2| P Mod01-002 Multiple Choice When the Doctor takes Rose 5 billion y « . . .
[5|»  Mos1003  MiipleChoics On Rose's first trp back in time she me 3. Under “How many questions in this set should
4| P Mo0l004  Mltile Choice In the Aliens of London episode the Do _| be randomly selected during the exam?”, select
Bl 2| | Mod01-005 Multiple Choice \What issue do the Slitheen aliens have h . All Sel N ber. If
§6l] | | Mod01-006 Multiple Choice The Doctor takes Rose back to her ow the Opthl’l next to or Seiect Numoer.
| 7|P  Mes0007  Msitiple Choice In 1941 London Rese and the Doctor € using the option Select Number, input a value
8 |P Mod01-008 Multiple Choice |n 1941 London Rose gets herself into v . . .
— =l in the box. This will be the number of

questions that display on the quiz from that
question group.

4. Type a point value for each question in the set.

5. Click Add New Set. Click OK when done.

Note: If you wish to use question groups for linking to a question bank, it is best to only upload the question
bank and create the quiz in Canvas.
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Canvas Q uiz Settings O ptional)

Canvas Guides

On the Settings screen click Settings from the left. This page will display many of the same settings you will see

when you edit a quiz in Canvas. (1) In the text box under Instructions type any desired text. (2) Select any

desired Canvas settings. Be sure to input dates and times as instructed on the screen.

Figure 8

'_R\ Respondus - Star Wars Example Test.rsp

File Edit View Help

=lolx|

HY |4 BB 7 u|x |z w|@reds | Broperedt | R

f | /" Preview

Settings

& Publish

Instructure Canvas

Canvas Settings

Question Groups

Settings

[{ Use As New Defaults

Settings ﬂ

When a file is published to a Canvas server, these settings are used if the “Apply settings" option is selected.

Instructions:

[~ Shuffle answers

I~ Publish now

Keep I vI Quiz Score

I~ Time Limit: I minutes

[V Let students see their quiz results

[~ Only after their last attempt

Limit to I attempts (leave blank for unlimited) [V Show the correct answers

MM/DDAYYYY  HH:MM

[~ DueDate I

™ Locked Until I

[~ Locked After I

Require an access code: (leave blank to disable)

Filter IP Addresses: I . I . I . I (leave blank or 0 to allow all addresses)

Prevew YourQ uiz

On the Preview & Publish screen you can preview all of your test questions. On the left click Preview and then
Preview the File. (1) Use the Go To box and the Prev and Next buttons to navigate the questions. (2)Use the

Modify Item button to make changes to a question.

Figure 9

Appearance in Intemet Explorer (other browsers may vary slightly).
1of 4
= ) }

=lolx|

Modify
|

Changes made in Edit will not appear until you Save the document. EioTo I
- ..'

Question 1: 1.00 pts

In Star Wars: A New Hope Luke lives with

O his father

O his mother

(O his auntand uncle
(@) by himself

Feedback
0.0% a.
0.0% b.

100.0% c.
0.0% d.

=l
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Publishng Q uestions

Once you have created the Respondus file, the test questions can now be published to Instructure Canvas. On

the start screen, make sure Instructure Canvas is the selected Personality.

1.

Click the Preview & Publish tab at the top of the Respondus screen. The Preview & Publish screen will
appear. On the left side of screen, click Publish to Canvas. Click Publish Wizard. On the next screen select
no. Click Next.

Minimize Respondus and open a web browser and navigate to one of your Canvas courses. Copy the web
address.

Figure 10

¥)) canvas Quizzes Workshop - Mozilla Firefox
File Edit View History Bookmarks Tools Help

. Canvas Quizzes Workshop l + J

€& @ https://lakeland.instructure.com/courses/1156978

Maximize the Respondus screen and in Respondus on step 2 of the Instructure Canvas Server settings dialog
box paste the URL In step 3 click Extract. On step 4 type in description (this can be anything you want). On
step 5 type in your user name and password. Tip: on your computer you can check the box next to
Remember my User Name and Password. Click OK. After you have configured steps 1-3, you will not have to
do this again. The server can be selected from a list.

Figure 11:

Instructure Canvas Server Settings ]

To automatically set the server information for your institution:

1. Open your browser, go to the Instructure Canvas server and log in. Cancel

2. In your browser, go to any course list page, then copy the Address line
from the browser into the box below Delete

il

|https: //lakeland.instructure.com/courses/1156978

3. Press Extract Server connection URL

Extract >> I Ihtlps://Iakeland.instructure.com/api/respondus/soap

4. Enter a name to describe this Instructure server (e.q. "My Instructure Server"')

Desciiption |Canvas

5. Username |snugent Password [

[V Remember my User Name and Password [save them on this computer) -
If this is a shared computer, un-check this box!
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On the next screen of the Publish Wizard select desire settings. (1) You can choose from a graded quiz or
question bank. (2) Edit the quiz name if desired or choose to replace an existing test in Canvas. (3) Be sure to
check the boxes next apply question groups and settings if you set these options in Respondus. (4) Click Next.

Figure 12

5
1. Select assessment type o
(¢ Graded Quiz \)

€ Practice (uiz
" Question Bank
€ Survey

2. Specify server action and item name e)
(¢ Create IStar Wars Example Test .

(" Replace the name of the existing server item does not change)

3. Other options @

[~ Apply Question Groups {not supported for surveys & question banks)
[~ Apply Settings {not supported for question banks)

4. Press [Next] to choose a location on the server

<ead<|—@L| oot |t |

Next >

4. On the next screen (1) select the desired course and (2) click Next.

Figure 13
Publish Wizard

1. Click on the area or folder to publish to, then press [Next]

ISR | course: "Canvas 105 - Creating and Managing of Cau

[29 graded quiz: "Display One Question at Time"
[ graded quiz: "Due Date with Availabilty Period"
Only existing graded quiz [ graded quiz: "Essay Questions” J
items will be displayed. [24) graded quiz: "File Download Quiz"
i [29) graded quiz: "Graded Survey”
gzﬁ:smsuvc; m [29) graded quiz: "Non-Graded Survey"
published to course [9) graded quiz: "Password Protected Quiz"
areas. [29) graded quiz: "Practice Quiz - Muttiple Attempts”
[ graded quiz: "Practice Quiz Example”
[ graded quiz: "Quiz Audtting” =
il [0 Aradad Az "Nz State” I LI_I
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The last screen of the Publish wizard will appear. (1) Wait until the screen displays Publish Completely
Successfully. (2) Click Finish. After you have published Quizzes and Tests to Canvas, be sure to double check all
your settings for each test or quiz.

Figure 14

Publish Wizard 5]

1. The status window below will update after each step of the Publish process.

I- Start Instructure Canvas Publish —
Respondus 4.0.5.15 July 2, 2015

* Export option discovery in progress...

* Validating discovery options and setting export parameters...
* Export option discovery succeeded.

* Export in progress...

* Initializing and checking options...

* Creating export folder...

* Writing QT files and resources...

* Creating zip package...

* Finalizing...

* Export succeeded.

* Publishing assessment to server...done.
~ Publish Completed Successfully - *0/
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Creating a Printed Test

You can also create printed tests directly in Respondus. Open a Respondus file. On the top menu click Preview
& Publish. On the next screen from the left side of the screen select Print Options.

Figure 15

R Respondus - Star Wars Example Test.rsp ;lgll]

File Edit View Help
u 27 | r}é ﬁ| B 7 U | Xo X° 2 <H> | @rﬂedra | @Powerﬁdlt | ?

( Start Edit  Settings el Instructure Canvas

Preview & Print Options

Publish Select from the options below, then either print the document or save it to a file for additional formatting

SN UiSING @ WOTd processor.
Preview g P

(Publish to Canvas 1. Select format: 0‘

ublish to Canvas

' Exam - Settings I
" Exam with Answer Key Settings I
" Answer Key only Settings |

2. Top of Page Contents (Headers)

Print Options

1o headers - =
EditHeaders | | =l

Preview ;l
3. Randomize Questions IDo not Randomize '16/'
I= Apply Question Groups from Settings
I= Randomize question order (including Question Groups if applicable)
[T Randomize answer choices within each question

I~ Group questions by type (Multiple Choice, etc.)

4. Questions to be included: from l to I (leave blank to include all ) 0/

Print Preview | Save to File | Send to Printer |

—

In step 1 of this screen you will be presented with several different format options. Select the desired format
option. Click Settings next to the selected option to configure how the test will appear when printed.

2. Step 2 allows you to create a header for your test. Click Edit Headers to modify the header for the test.

3. Step 3 gives options for creating multiple versions of the test. Choose the desired option. If you have created
question sets they can be applied as well.

4. Step 4 allows you to choose how many questions will be included in the test. Leave blank to include all
questions. For final output you can choose the desire option. Select Save to file to save the file in the rich
text format you can open in Word.
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O nlne Resources

Information Systems & Services staff has created instructor tutorials on using Canvas. The Instructure website
also has plenty of great resources to help Instructors learn how to use Canvas. Instructors can also interact with
the Canvas community as well as submit feature requests and get help with any technical issues.

Respondus Website

https://www.respondus.com/

LLC Instructor Canvas Tutorials
https://lakeland.instructure.com/courses/1455362

Canvas Community
https://community.canvaslms.com

Getting Started in the Canvas Community

https://community.canvaslms.com/community/meta/getting-started

Canvas Guides
https://community.canvaslms.com/community/answers/guides

Canvas Release Notes

https://community.canvaslms.com/community/answers/releases

Canvas Roadmap & Feature Requests

https://community.canvaslms.com/community/ideas
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